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Elements is a photo editor an
gives you the control to find, cate g e,[ edlt
and share your favourite images -ef‘fo tlessly.

It is very likely that in this digital age, the number of photos you have on your
computer is vast. It is very easy to take photos and deposit them on your computer
and never look at them again. It is also likely that you have photos that you really
like but that might be underexposed, badly lit; or could be improved if you were
able to remove an annoying background distraction. You may even want to cut your
subject out, put it into another scene entirely and create a new look for an image.

If you've ever wanted to do more with your photo collection but didn't need the
advanced power of Adobe Photoshop CC, then Elements is for you.

Now, thanks to Adobe Photoshop Elements, you have an easy and affordable
means to find all those elusive images, organise them and manipulate your favourite
ones to make them even better. It Is easier than ever to quickly and easily make your
Images look amazing with just a few clicks of your mouse. From automated and
guided edits to hands-on expert modes, you can create exactly what you want. The
only thing holding you back is your imagination.




CONTENTS %+

Lmﬂ\"ﬂ“f.‘ N

Photoshop Elements Manual

6 Starting with Photoshop Elements 32 Using Adobe Camera Raw
8 What is Photoshop Elements? 34 The Camera Raw Interface

9 More Advanced Options 34 |nthe Raw

10 The Elements Home Screen 35 Control Tabs

10 Search Option 36 The Histogram

11 Explore the Guides 37 The Profile Browser

12 The Quick Mode Workspace 38 Camera Raw Processing

12 Mode Selector 43 Raw to Photo Editor

13 Create and Share 46 Saving to DNG Format

14 The Guided Mode Workspace

15 The Taskbar Getting Organised

16 The Expert Mode Workspace 50 The Organiser Workspace

16 Tools Options Panel 52 Setting Up Elements Organiser

17 Panels 54 Tagging and Keywords

18 The Expert Mode Toolbar 56 Putting Names to Faces

19 Key to Symbols 56 Add Name

20 The File Menu Layout 57 Add Group

21 Shortcuts 58 Tagging Photos with Location Data
22 Guided Mode Categories 58 Number of Groups

Adding Events Tags to Photos

Name Event

Reviewing and Comparing Images

Comparing Photos Side-by-side

Watched Folders

Import from a Digital Camera

The Advanced Photo Downloader

Search by Metadata, Similarity & Objects

Using Instant Fix

4

BDM'’s Independent Manual Series | Volume 19




76 The Elements Experience
78 Open Closed Eyes

118

Brush Tool

80 Partial Sketch

120

Eraser Tool

82 Replace Background

124

Modify, Crop, Move and Recompose

84 Photomerge Panorama

124

Crop Tool

86 Meme Maker

125

Recompose Tool

88 Multi-photo Text

126

Content-aware Move Tool

90 B&W Colour Pop

127

Straighten Tool

92 Zoom Burst Effect

128

Panels and the Panel Bin

94 Old Fashioned Photo

130

Customise the Panel Bin

96 Depth of Field

132

How to Correct and Enhance

98 Your Guide to Image Editing
100 A Guide to Using Layers

134

Levels Adjustments

136

How to Use Colour Balance

138

Enhancing Balance

140

Quickly Resize Your Photos

142

Selecting Fine Edge Detall

144

Cleaning a Scene

146

The Artwork Library

148

The Favourites Panel

150

How to Make a Photo Book

154

Photo Book Advanced Mode

156 Take Your Skills Further
158

Sky Replacement

164

Freguency Separation

170

Composite Images

102 Methods for Adjusting an Image

178

Dodging and Burning

106 Using the Photo Editor Expert Mode

184

Using Selective Colour

110 Working with Selection Tools

188

The Orton Technique

112 Cloning, Healing and Enhancing

118 Draw, Fill, Shapes and Text

192

Glossary

CONTENTS

Free Media Download

We have compiled this exclusive media
download so you can work alongside
our expert team with our step-by-

step guides. To take full advantage of
this exclusive offer for all readers of

this publication, you simply need to
download these essential free resources.
To do this, just visit us at:

LOOK OUT FOR
THIS LOGO

Any tutorial
displaying it
indicates that it
will be available
to download
from our site.

This tutorial
content is
available for
download

bdmpublications.com/ultimate-photoshop

Then you will need to register, log in and finally select this title from the listings to
begin your download. So visit www.bdmpublications.com/ultimate-photoshop today
and take advantage of this amazing opportunity to enhance your reader experience.
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Starting with
Photoshop
Elements

If you are new to Photoshop Elements, cataloguing your
photos and digitally manipulating them may seem like a whole
nhew world you have to conquer. Do not worry though, we will
guide you through the basics and get you started on your way
to becoming a skilled user of the software. We hope to have
you importing, tagging, organising and editing your photos
like a pro in no time at all. With that in mind, let's begin the
journey and get you more familiar with how it all works.

6 BDM'’s Independent Manual Series | Volume 19
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SIARTING WITH PHOTOSHOP ELEMENTS

What i1s Photoshop

Elements?

Let's take a moment to get to know a little more about the software

and how it can help you with your day to day image editing.

dobe Photoshop Elements is a
great option for those who want

an extensive toolset that can take

on most of their image editing needs,
without the requirement of highly
advanced features such as you would
find in Photoshop CC. It is also a great
choice for those who only need one-
click solutions to their image editing
needs, or perhaps want to start to
learn how to take on the more involved
techniques and tools that Elements has
to offer. Another big plus point in its
favour is that it is one of the very few
remaining Adobe products that can be
purchased outright, without the need
for subscription.

A Worthy Alternative

There was a time when, in certain
guarters, Elements was considered a
dumbed-down version of Photoshop
with a limited toolset, that was

only meant for beginners with no
aspirations to advance to the more
technically advanced technigues seen
INn Photoshop. However, recent versions
of Elements have shown that it is a
worthy standalone alternative to using
Photoshop. It Is a focused image editor
and cataloging application that is more
than capable of taking on any image
editing task you care to send its way.

INn its current form, Adobe Photoshop
Flements is comprised of two main
components. One is the image editing
module of the software where you
can touch up your photos or even
manipulate and transform them beyond
recognition. The Edit section is broken
down into three sections. The first is
the Quick Edit mode, then comes the
Guided Mode section and finally there Is
the Expert mode.

Make the Most of Modules

Fach module has its own set of tools
and preset options that can quickly get
the job done. Quick Edit, as the name
suggests, contains the basic editing

BDM'’s Independent Manual Series | Volume 19
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WHAT IS PHOTOSHOP ELEMENTS?

The Adobe Photoshop Elements and Organiser interfaces are
designed to be as intuitive as possible with plenty of options
for beginners and experienced users alike.

tools such as colour correction, cropping,
quick selection, spot healing, sharpening and
lighting fixes. You can also apply some one-
click presets such as Smart Fix, Exposure
and Lighting.

Helping Hand

The Guided module is also fairly self-
explanatory. Here you can make any number
of popular image adjustments to your
photos, with guided step-by-step tutorials,
such as altering brightness and contrast,

.

resizing photos, rotating and straightening @ ¥ O C ) ry

Phaato Bin * Tood Options - Uindo Rt Rotate  Organiser Home Soreen

your images and adding vignhettes. It also
Nas a number of specialised and fun options
for restoring old photos, creating your own
frames and replacing backgrounds.

More Advanced Options

Finally comes the Expert mode. This has
more of the feel of its big brother, Photoshop
to it. It has a toolbar ranged down the left
hand side of the workspace and on the right
IS the layers panel that behaves much in the
same way as Photoshop's layers palette. Here
YOU also have access to a number of photo
colour presets such as Faded Photo, Glow
and Monotone Color. There are also a number
of filters for more artistic effects such as
coloured pencils, watercolours, distortion
effects and sketch filters. You can also ado
Bevels, Patterns, Strokes, Photographic
Effects and much more by accessing the | | i S e - 1
icons in the lower right of the taskbar at the Y - 311 3 | | e s
bottom of your workspace. Expert mode | P
IS the most hands-on of the three modes
you can employ and gives you access to
all the tools, so you can apply all your own
advanced edits to your photos.

uuuuuuu

HHHHH

Galcorn b

Getting Organised o

The second main component of the latest
Adobe Photoshop Elements is the Elements
2019 Organiser. At its heart, this is a

cataloguing and photo organising program it detects a similar name being entered editing tools that will keep beginner ano
that lets you import, sort, tag and rate your as a tag, it will display those existing expert happy.

photos. If you wish, you can create albums names similar enough as a match to be Over the page we'll begin to delve

and use names, locations, date, time and GPS  an option for tagging. deeper into the workspaces offered by
data to sort them. The program can even The two components of Photoshop the Editor and Elements Organiser. It is
employ face recognition to find and sort Elements and Elements Organiser best to consider the Editor module as your
photos of people and tag them much as you are separate programs, which can be digital darkroom and design studio and to
would In Facebook. Indeed, you can actually a bit of nuisance If you need to keep think of Elements Organiser as your library,
Import your list of Facebook friends as an switching petween them but you have where you keep all your media items such
ald to tagging the people in your photos. If at your disposal a set of powerful as photos and videos.

www.bdmpublications.com 9



SIARTING WITH PHOTOSHOP ELEMENTS

The Elements
Home Screen

We start the journey by becoming more familiar with all the module
environments you will be working with.

L T LB |

Welcome Home L X o

When you open Adobe Photoshop
Elements 2019, you are presented with a
Home screen. This simple screen is your e.g. | would like to make a greeting card
gateway to the Photo Editor program or
the Organiser. The third option available
Is to activate the Adobe Premiere
Elements Video Editor, if you have
purchased that as well. If not, it will ask
If you want to download a trial version.

You also have the option at the
top of the Home screen to search for
help on things you want to achieve In
the programs or to click on any of the
featured Try This guides and What's New
items and Inspiration articles rangeo
across the screen.

On the extreme top right of the page
are buttons for Facebook and Twitter
and a Help button that takes you to
Adobe Customer Support.

What would you like to do today?

f I

TRY THIS

Create a Slideshow

3

Auto Creations

o Search Option

From the home page you can can search
for things you need to learn more about.
If you want to learn how to make a
calendar for instance, type that in the
search bar and it will show you links to
help files that can tell you more.

9 Featured Guides

Ranged along the top of the home page
are a number of clickable guides and
inspirational media that gets you into the
heart of what Photoshop Elements 2019
is all about. There are several themes
yOU can access. Try This are guideo
tutorials that help you create exciting
media and art. What's New highlights all
the step-by-step features that are new
to this version. Inspiration is a collection
of stories and articles to get you in a
creative mood.

Import more media
for Auto Creations

Add media to your
Organizer 1o receive
creations of your favorite
MEemaries.

10 BDM'’s Independent Manual Series | Volume 19



o Auto Creations

When you open the home page for the
first time, you will be prompted to ado
media for Auto Creations to make a
series of personalised creations, such as
slide shows that use your own photos
and videos.

o Add Media

Auto Creations are created with media
(photos or videos) that you've imported.
If you haven't imported any media vet,
click Add media under Auto Creations on
the Home screen and relaunch the app.
You can open and edit any Auto Creation
and instantly share it with your family
and friends.

) Program Chooser

To the right of the home page are the
icons for Organiser, Photo Editor anad
Video Editor. You can click on these to
activate the relevant program. If you do
not have the Adobe Premiere Elements
video editor program for instance, it will
ask you if you want to try if for free with
the option to purchase later It you wish.

o Recent Files

ANy iIMmages you have pbeen working on
recently will be displayed here for quick
access. Click on the image you want

to continue working on and it will be
opened within the relevant program.

Q00

L

WHAT'S NEW

Organizer

o RECENT FILES

g dawlish 1.jpg

Add luma fade transitions

j;‘f----.; . Photo

Fl v

INSMRATION

| Video

Editor . & Editor

Add a spes

THE ELEMENTS HOME SCREEN

o Facebook Button

Click this button to go to the Adobe
Photoshop Elements Facebook page.

o Twitter Button

When you click this button, it will take
you to the Photoshop Elements Twitter
feed where you can view, reply to,
retweet and like tweets.

o Help Button

If you need further assistance, you can
click this button to be directed to the
Adobe Customer Support webpage.

Explore the Guides

For those who are in need of more guidance, or just
some creative inspiration, go ahead and click on any of
the featured guides and articles to explore more of the
online world of features Adobe Photoshop Elements has
to offer.

Adobe Premiere Elc:

Guide » Introduction to Adobe Premiere Elements Select an

3 Fade Transition effect - Guided E

itic scene transition by fading in the colors!

d edit to create a cool transition effect between two video clips, two imag
ion effect creates a dramatic scene transition by fading in the colors from da

information, see Create a Luma Fade Transition effect - Guided Edit.

www.bdmpublications.com 11



STARTING WITH PHOTOSHOP ELEMENTS

The Quick
Mode Workspace

For fast and simple edits, this is the mode to get you editing
quickly, with one-click results for better photos.

One_click Power @ Adobe Photoshop Elemen 1 Editor File Edit Image Enhance Layer Select Filter View Window Help

Although this mode is designhed to

be quick and simple to use, it is still a
powerful method to rapidly improve
your photos with easy one-click
presets that give you instant feedback
on how your image will look with the
new adjustments applied. There are
many filters to choose from and many
ways you can adjust your image to
make it perfect, so you can share it
with the world.

o The File Menu

Although a number of file menu option
will not be accessible, the main ones
that you need will be available. All the
Enhance options are there as well as the
Filter Gallery presets.

e Mode Selector

Here can you can exit the current mode
and choose to enter the Guided or
Expert modes.

e The Open Button

This Is a simple button to specify a new
project to work on. Click it to create a
new document at the size you want.
When you click OK, the document will be
created and can be worked on in either
Quick mode or Expert mode.

o The Toolbar

The Quick mode toolbar has a core set

of tools to get your image looking great Hand

with minimal effort. You can make quick | = m

selections to specific areas of the photo, E REM mumm “gh

crop It, straighten the horizon, whiten

teeth and fix eyes as well as adding text o _ .

and a number of varied filters, textures ad D C " )" ﬁ

ana adJUStmEHtS. Photo Bin ‘Tool Options: Undo Redo  Rotate Organizer Home Screen o
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o The Tool Options Bar

For every tool you activate in the toolbar,

you have another panel called the Tool
Options bar that gives you many more
choices as to how that tool can be
modified and controlled. There are also
additional tools that can be accessed In
the Tool Options bar.

o The Taskbar

The taskbar is situated at the bottom
of the workspace and contains all the
most frequently used actions, which are
displayed as buttons. Click each one
and you can see all the images you are
working on at that time, display or hide
the Toolbar Options bar and Undo or

redo any steps you have performed on
your image. You also have the option
to rotate the image and activate the
Elements Organiser If you need to.

o View Options

Clicking on this button reveals the View
options. This is useful if you want to
compare a before and after view of your
currently active image, to see how much
the image has changed from its original
untouched state.

o Active Image Area

The image you are working on is
displayed in this area. It will either be as
a single image or, if you have chosen a

= B O

Adjustments Effects Textures Frames

THE QUICK MODE WORKSPACE

different view option, as two images that

represent the before and after state of
the photo.

o Zoom Slider

This slider lets you quickly zoom your
iImage from 1% all the way up to 3200%.

@ Create and Share

These two dropdown menus display
options for creating slide shows, photo
books, greetings cards, calendars,
Facebook Covers and much more. You
can also share your works of art on
Facebook, Flickr and Twitter.

0 The Panel Bar

This panel changes content depending
on what adjustment or effect you are
using. If you are using the Adjustment
tools, then they will be displayed in
the right hand panel bar. ltems such as

Smart Fix, Exposure, Lighting and Colour

will be available here and each can be

clicked to reveal its available options. The

Effects menu, Textures and Frames are
also available to be accessed here.

Create and Share

Don't forget to check out the Create and Share
options. Whether you want to share your creation

online and on social media or make prints of your

photos or even calendars, click the buttons to
explore further.

4'))

Slideshow

Photo Caollage

Photo Prints

Photo Book

Greeting Card

Photo Calendar

CD Jacket

DVD Jacket

W /'DVD Label

’V

[ Slideshow
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SIARTING WITH PHOTOSHOP ELEMENTS

The Guideo
Mode Workspace

This mode is great for accomplishing a variety of effects, with
a handy guide for each one you use.

o Category Selector

Here can you can select which effect you
want to apply to your image. There are
siX categories of effects to choose from.

9 Basics

Contains the Basic effects Brightness
and Contrast, Correct Skin Tone, Crop
Photo, Levels, Lighten and Darken, Resize
Your Photo, Rotate and Straighten,
Sharpen and Vignette Effect.

o Colour

This category contains Enhance Colour,
Lomo Camera Effect, Remove Colour
Cast and Saturated Film Effect.

Layer Select =ilter  View  Window

i Adobe Photoshop Elements 2018 Editor Flle Edit Image Enhance

EFFECTS COLLAGE

Create a fun collage by adding multiple
effects to a single photo.

Bring one photo to life within ancther to
create a surreal effect.

SPEED EFFECT SPEED PAN

Aok somee action with motion blur. Add a motion blur Lo the badoground o
cresale the Impression of speed. with

Turn photos and text into fun memes for
social media.

VO 2 THEAIRArer S Aotforcg® .
: . gl
| . - b

o Black & White

This section has a number of effects
centred around monochrome. Black and
White, B&W Colour Pop, B&W Selection,

High Key, Line Drawing and Low Key.

e Fun Edits

You can find a lot more creative edits
under this category. You have some
diverse effects to try out such as Double
Exposure, Effects Collage, Meme Maker,
Multi-photo Text, Old Fashioned Photo,
Out of Bounas, Painterly, Partial Sketch,
Photo Text, Picture Stack, Pop Art,
Puzzle Effect, Reflection, Shape Overlay
Effect, Speed Effect, Speed Pan ano
/Zoom Burst Effect.

Quick Guided Expert

Bagics Colar Black & White Fun Edi* Special Edits

E-.ma

MULTI-PHOTO TEXT .D FASHIONED PHOTO

Create visual text with a different photo inside
each letter

II"'I.II.II.E EFFH"l
Conmveart your photo

Transform your phobo inte a fun and colorful
Pop Art masterpioce

b & jigsaw purde.

Quick

Basics Color Black & White

4

- -
L

1

Photomarge

your photo back in time by giving it an Make the subject of your photo pop out of the
oned look.

edges with this 3D effect.

Add a reflection to create an interesting look.

cn - B Expert

Fun Edits

0 0 Om

o Special Edits

More specialised image manipulation
effects are kept in this section of the
Guided edit workspace. It contains
Replace Background, Depth Of

~leld, Frame Creator, Orton Effect,
Perfect Portrait, Recompose, Replace
Background, Restore Old Photo,
Scratches And Blemishes, Text

and Border Overlay, Tilt-shift and
Watercolour Effect.

o Photomerge

The Photomerge section mainly
concentrates on blending two or more
ohotos or extracting and merging
subjects from one shot into another.

w = o)) MonBOcot 10:21:26 Q

Give your photo an artistic painting effect.

SHAPE OVERLAY EFFECT

Add a shape overlay effect bo create an
artistic look:,

Special Edits

Show Open Files - |

paAm

A

Photo Bin - Tool Options:  Undo

C D-E T

Rado Rotate annll:nr Homa Scraan
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There's Photomerge Compose,
Photomerge Exposure, Photomerge
Faces, Photomerge Group Shot,
Photomerge Scene Cleaner and
Photomerge Panorama.

o Open

If you choose to select a new image from
the Open menu during a guided edit, you
will be asked If you want to discard the
current guide, In order to start a new one
with the image you are about to open.

o Zoom Tool

Click the Zoom Tool icon or press Z to
activate the zoom tool. You can magnify
the image up to 3200%. Wherever you
click with the mouse, the image will be
magnified and the point you clicked will

be placed in the centre of the workspace.

Press the Alt key on your keyboard to
decrease the magnification factor.

@ Hand Tool

Click the Hand Tool icon or press H to
be able to move your magnified image
around. With the Hand Tool active, click
and drag your photo to move it around
within the active image area.

0 View Options

Clicking on this button reveals the View
options. This is useful it you want to
compare a before and after view of your
currently active image, to see how much
the image has changead.

& Adobe Photoshop Elements 2019 Editor

File Edit Image Enhance Layer 3Seiect Flter

View Window Help

@ Photo Bin view

Where appropriate, this menu button
displays options on how to view

any currently active images that are
contained in your Photo Bin.

@ The Taskbar

The taskbar is situated at the bottom of
the workspace and contains all the most
frequently used actions.

@ Active Image Area

This i1s where the image you are working
on will be displayed.

@ Zoom Slider

This slider lets you quickly zoom your
image from 1% all the way up to 3200%.

@ Guided Steps Panel

Whichever effect you choose to apply
to your image, the steps required to
complete it are displayed as numbered
steps in the guidance panel on the

right of the active image area. You can
follow the steps, clicking the appropriate
buttons and altering parameters until
yOu are ready to commit the changes.

Q Next and Cancel

Click Next to commit the changes of the
guided edit you have just applied or click
Cancel to cancel the edit entirely anad
begin again.

Quick Guided Expert

THE GUIDED MODE WORKSPACE

@ Save

Once you have clicked Next, you can
choose to save your image or save it
under a new name and/or image format.
You can also elect to continue working
on the image In either Expert or Quick
Mmode. YOu can also choose Share to
upload it to Facebook, Twitter or Flickr.

@ Done

Simply returns you to the Guided
category page. If you ook in your

Photo Bin, your image will have a small
brush icon in its top right corner, which
indicates it has edits applied. If you close
the image and haven't saved it, you will
be prompted to do so If you wish.

Create ~ Share ~

Picture Stack @

What would you like to do next?

Save.

Save Save As

After (Roll over to

1. Select Number

15 Joom: o= mess———— AR

6

b a

4 Pictures 8 Pictures 12 Pictures

2. Change Border Width
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SIARTING WITH PHOTOSHOP ELEMENTS

The Expert
Mode Workspace

For those who have developed their skills to the point where they
are comfortable getting more hands-on with their images.

Open Quick Gui

o The File Menu
VIEW x fox-1883658.jpg @ 66.7% (RGB/B) * | * landscape 237.jpg @ 4 a/Saturation 1, Layer Mask/8) *

Most of the File menu options will be Q \% ks
made avallable to you in this particular T
workspace, since all the tools and o ol
effects parameters are there to be used i
manually with little or no guidance from & N\
the program.

e The Open Button .L

Common to each workspace, click on
the Open pbutton to view any recently

active images you have been working on &k f—‘

or to create a new blank file ready to be
worked on. / #

o The Tools Panel L ;.

. [ [—
This panel contains all the essential tools XC s |

you are going to need for powerful and ST
flexible Image editing. It is broken down o
into View, Enhance, Draw, Modify and -
Colour sections.

o Document Tab

Each image that is open will be marked
by a document tab to identify each
image. It will display the filename of the
ohotos currently open.

o Active Image Window

This displays the current image you are
working on.

o Document Info

You can choose what information about
your active document is displayed here.

o Tool Options Panel

This panel is context sensitive anad Smart Brush 5
displays additional options and controls -1 m ®  Sit O 13pc | @inverse
for each tool that you select from the 0 . = | Brush Settings... | | Refine Edge....

tool panel.
f\?\‘ﬂb c”).m n

Photo Bin ‘Tool Options® Undo edo Rotate  Layout Organizer Home Screen

0 000

. Blue Skies (
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THE EXPERT MODE WORKSPACE e

o Photo Bin

0 Layout @ Layers

The Photo Bin panel displays thumbnails If yOou have a humber of documents One of the key aspects of more

of all open photos currently being useo open at one time, you can choose from a advanced image editing Is to be able to

by the program. number of layout options to display them work across multiple layers within your
all at once within your active image area. active document.

o Undo/Redo

@ Switch to Organiser @ Effects
Clicking the Undo button allows you to _—m—mm—m m tT{ _—m
step back through any actions you have Clicking on this button will open up the This will display all the effects options
performed on your image. Redo allows Elements Organiser program where you currently installed. They range from
you to step forwara. can view and select images that you rubber stamp effects to pencil sketch
have imported and catalogued. effects and colour tints, which can all be
@ Rotate Tools applied to your photos.
@ Home Screen _
Allows you to rotate your image in 45° —_—mm m @ Filters
steps either clockwise or anticlockwise. Click this button if you want to return to
the Home screen. Ranging from artistic effects to brush

strokes and distortion and pixelation
options, clicking the Effects icon will
display all the creative effects available
to be applied to the image.

fed Expert = Sha; ; Q Styles

Opacity: | 100%| *

There are a number of colour, texture
Histogram - : - T and special effects that can be applied
U= LS ! | to any subject that is currently on a layer.
They range from fibreglass textures to

fire, chrome, bevelled edges and tints.

Source: | Entire Image | ) - @ G ra p h I CS

Mean: Level: Ry 4 = -
. e “8 These are background graphics that can

Percentile: be downloaded and used as backdrops
IN your compositions.

Hue/Saturation g M 0 re
Channel: | Master | -

A pOop Up Mmenu where you can open
more currently hiaden panels.

Brightness/Co...

Lightness: m—()
(] Colorize | @ Layer Options

@ i | This panel allows you to aad new layers,
et group selected layers, adjustment layers
and Mmasks.

@ Layers Panel

o —~ This I1s where layers are viewed and
Loy R Jé_t m Navigator | Favortes | Actions . consists of the base backg rouhd layer
St AC R | and any subsequent layer copies, brand
e~ R e — new layers or layer adjustments.

@ Layer Properties

For each layer adjustment you add, you
have the corresponding properties panel
to control its effect.

When you click on any of the Layers, Effects,
Filters Styles and Graphics buttons, the main
panel on the right of the screen will display the
corresponding panel for each one you choose. Our
example is currently displaying the Layers Panel.

1415 J16 1718 10,

¢ @ 5w + @3

Layers  Effects Filters Styles Graphics More
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SIARTING WITH PHOTOSHOP ELEMENTS

The Expert
Mode Toolbar

All the main editing tools you need Iin Expert mode are accessible
from the toolbar on the left of the workspace.

I f you've used older versions of Elements VIEW EMHAMCE R AW MODIEY

or Photoshop, the main components (e | == | |——| |— |
of the toolbar will be familiar to you. | f . t

There have been updates and additions Q ‘i\[_b% <& # I [3
to the tools available but most will be | ' -

recognisable for what they are and you T T e TS

should be able to get to grips with the , & .
newest ones without too much issue. SELECT

Although each tool has additional options
displayed down in the Tools Options N - - - | |
| e | - | _ * When you click on any of the Layers, Effects,
e S| | Filters, Styles and Graphics buttons, the main

Panel, if you hold the Alt key and click on
panel on the right of the screen will display

a toolbar icon, you can cycle though all

variants of that particular tool to get to -

the one you want. Here is a breakdown of ? E \.\ : I s ’ the corresponding panel for each one you
the toolset available in Adobe Photoshop - i | - choose. Our example is currently displaying
Elements 2019. - e | the Layers Panel.

@ Adobe Photoshop Elements 2019 Editor File Edit Image
—m . The Tool Options bar

VIEW X boat-1620452.jpg @ 50% (RGB/8) *

Q ¥

SELECT || The Tool Options bar

" 13 appears at the bottom of the
o & Photoshop Elements window
e D and it displays the options for

any selected tool in Expert and
Quick mode

‘o [0

'4-’ Spot Healing Brush Tool (J) .
é : w1 SRA 8 . i WP sy ¢ v ¥ I a0 1 Actfve TOO'
DRAW . :
B The currently active tool is
.

highlighted.

2 Related Tools

Any related tools associated i Doc: 68.
with the main tool, selected Spot Healing Brush

from the toolbar, will be — _, :

displayed here.

3 Additional Options e

For any tool that you have

selected and have active, there | Sample
are a number of additional : _
options that let you control — L oy =l | =
e = = various parameters relating to "! g j & . )' L e
e that particular tool. ik =

Tool Dpﬁnn55 Undo Redo Hotate Layout QOrganize
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View Tools

The tools found in the View Tools section
of the toolbar are designed for basic
magnification: zooming in and out of
your photo and moving it around the
screen to view a portion of the zoomed
iImage at your chosen magnification.

1 /oom (Z)
2 Hand (H)
Select Tools

This section covers all the tools that
allow you to select all or parts of your
Image for targeted editing, cutting out or
duplication to new layers.

3 Move (V)

4 Rectangular Marguee (V)
5 Elliptical Marquee (V)
6 Lasso (L)

7 Polygon Lasso (L)

8 Magnetic Lasso (L)

9 Quick Selection (A)
10 Selection Brush (A)
11 Magic Wand (A)

12 Refined Selection (A)
13 Auto Selection (A)

Enhance Tools

The set of tools found in this section of
the toolbar are for enhancing the image.
You can heal, clone, blur, sharpen and

Key to Symbols

THE EXPERT MODE TOOLBAR

use targeted contrast effects on your
ohotos and much more.

14 Eve (Y)

15 Spot Healing Brush (J)
16 Healing Brush (J)

17 Smart Brush (F)

18 Detailed Smart Brush (F)
19 Clone Stamp (S)

20 Pattern Stamp (S)

21 Blur (R)

22 Sharpen (R)

23 Smudge (R)

24 Sponge (R)

25 Dodge (R)

26 Burn (R)

Draw Tools

The Draw section of the toolbar contains

various elements that let you paint, draw,
erase and sample colours in your photos.

The text tools are also In this section.

27 Brush (B)

28 Impressionist Brush (B)

29 Colour Replacement Brush (B)
30 Eraser (B)

31 Magic Eraser (B)

32 Background Eraser (E)

33 Paint Bucket (K)

34 Gradient (G)

35 Eyedropper/Color Picker ()
36 Custom Shape (U)

37 Rectangle Shape (U)

38 Rounded Rectangle Shape (U)

et afafe i@
D 2r A
OO Sz Cu )]s
) 1) ] ) P Tl T o

39 Ellipse Shape (U)

40 Polygon Shape (U)

41 Star Shape (U)

42 [ ine Shape (U)

43 Shape Select (U)

44 Horizontal Type (T)
45 Vertical Type (T)

46 Horizontal Type Mask (T)
47 Vertical Type Mask (T)
48 Text on Selection (1)
49 Text on Shape (T)

50 Text on Path (T)

51 Pencil (N)

Modify Tools

This set of tools is primarily concerned
with how you can affect the crop and
intelligently move items in the frame for
different compositions.

82 Crop (C)

53 Cookie Cutter (C)

54 Perspective Crop (C)

55 Recompose (W)

56 Content-Aware Move (Q)
57 Straighten (P)

Colour Tools

Here you can set your foreground and
background colours, swap them over if
required, access the colour picker and
set back to default as required.

58 Colour Tools

www.bdmpublications.com
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SIARTING WITH PHOTOSHOP ELEMENTS

The File
Menu Layout

Get yourself familiar with the file menu system and you will see
just how powerful the program can be.

dobe Photosh op @ Adobe Photoshop Elements 2019 Editor File Edit Image Enhance Layer Select Filter View Window Help
AEIements has many one- Atout 1R M

click solutions to make System Preferences...
your phOtOS look their best | App Store... 440.jpg @ 66.7% (Levels 1, Layer Mask/8) * | x monument-valley-53637.jpg @ 50% (RGB/8) *
but over time you may find the Recent items > -y 57 P S T e s .\

| | f .T:?;‘.F;":- -.-‘: '_.111 N P

Newd ko Glg deaper nie the Force Quit Adobe Photoshop El ts 2019 Editor 0% ! [ Atk il oals’ \i
. rce Wul oDe OLOosSNOo ements IiHor " “llPy  ¢. 3

more advanced options that are i 4 e |

on offer with the Photo Editor. Sleep

Many options are presented in Restart...

the taskbar at the bottom and Q- SOWn...

the panel bar on the right. If |  Lock Screen ,. ; | OB
you need them however’ the Log Out Mark Frost... AP | ! Ly i - . -}‘_- ‘q‘ o

File Menu is where you can find
all the vital tools.

Adobe Photoshop Elements

About Photoshop Elements... ' Undo Rectangular Marquee 382 Rotate
About Plug-In Open... at 0 T

. . ransform
Legal Notices... Open in Camera Raw... 30 Revert GEA

Preferences Open Recently Edited File  » - Crop
_ Duplicate... g”t - é Recompose
o i Divide Scanned Photos

_ ~ae Close 3£ W Copy Merged e
Hide Photoshop Elements H Close Al Paste gp \/ esl|Ze

Hide Others \dH S ave 95 © Paste Into Selection

Save As... Delete Mode

. Convert Color Profile
Save for Web... Fill Selection...

Stroke (Outline) Selection...

Quit Photoshop Elements 6 Q

File Info...

Place...
Organize Open Files...
Process Multiple Files... Clear

Import
Color Settings...

Preset Manager...

Print. Start Dictation...

Contact Sheet ll...
Picture Package...

From this menu you can see One of the key menus you INn Many ways, Edit is quite Here you can make many

the About screen and manage access at the start and end of similar to the options available changes to your photos. You
any Plug-ins as well as update a session. You can create new on a word processor. You can have various rotation and

vour Preferences and quit documents, open existing ones copy, paste, delete or merge transformation options along
Photoshop Elements. You can and save them. You can also iIMmages. You can also fill with cropping and resizing. You
also view any legal notices or Import or print your documents  selections, alter colour settings can also convert the colour
nide the workspace. and create contact sheets. and undo actions. mode or profile of the iImage.
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Auto Smart Fix

Auto Smart Tone...
Auto Levels

Auto Contrast

Auto Haze Removal
Auto Color Correction
Auto Shake Reduction
Auto Sharpen

Auto Red Eye Fix

Adjust Color

Adjust Lighting

Adjust Smart Fix...

Convert to Black and White...
Haze Removal...

Adjust Sharpness...
Open Closed Eyes...
Adjust Facial Features...
Shake Reduction...
Unsharp Mask...

MNew
Duplicate Layer...

Delete Layer Deselect

Hename Layer...

Layer Style Inverse

MNew Fill Layer
MNew Adjustment Layer

All Lavers
Deselect Layers

Feather... 3D
Refine Edge...

Modify >

Type

Layer Mask
Create Clipping Mask Grow

Group Layers Similar

Hide Layers Transform Selection

Arrange

Merge Down
Merge Visible
Flatten Image

Save Selection...

THE FILE MENU LAYOUT

Filter Gallery...
Correct Camera Distortion...

Adjustments
Artistic

Blur

Brush Strokes
Distort
MNoise
Pixelate
Render
Sketch
atylize
Texture
Other

yF 7y vy vyryvyryryryyTyyy

v

Digimarc

This menu has all the creative
and fun filters that can add
new life to your photos. Add
blur, sharpening, distortion
and artistic effects at the
click of a button.

Every time you make a
selection of all or part of your
image, you can modify its
oroperties here. You can feather
the edges, expand or contract
It, Invert it and save it.

NN NN TS

New Window for mill-1620440.jpg Search

A vital aspect of image
manipulation is the ability to
add layers of effects to your
Image. Here you can add new
layers, fill layers and agjustment
layers for non-destructive edits.

Many of the main adjustment
options are found here. They
range from contrast, brightness
tone, sharpness and colour. You
can also access the Open Closed
Eyes feature and much more.

Images

Zoom In
Zoom Out
Fit on Screen
Actual Pixels
Print Size

When you explore the file menus on
offer in Adobe Photoshop Elements,
each menu and sub-menu will
always display the keyboard short
cut next to the action or tool. To
speed up your work flow, it's always
a good idea to become familiar with
those short cuts.

v Tools Photoshop Elements Help...

Getting Started...
Key Concepts...
Support...

Video Tutorials...
Forum...

Actions

Adjustments

Color Swatches

v Selection Eﬁ’emfs
Rulers Favorites
Grid Filters

Graphics

Histogram

History

Lock Guides . Info

v Layers
Mavigator
Styles

Home Screen...
Snap To

System Info...
Manage My Account...
Sign Qut (mark.frost@bdmpu

New Guide...

v Panel Bin
Resef Panels

hong-kong-1990268.|pg
v' mill-1620440.jpg

Should you need it, you can
enter search parameters for
any Issues you encounter. There
are also a number of options
presented to you that can help
yOu in certain situations should
they arise.

This menu lets you control

the visibility of certain tools
and panels and turn them on
and off as needed. The major
adjustment panels, including
Effects, Layers and Filters, can
be controlled here.

Some of the basic zoom In
and zoom out options are
kept here Including being able
to view the print size of your
Image or turn the visipility of
rulers, grids and selections on
and off.
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SIARTING WITH PHOTOSHOP ELEMENTS

Guided Mode
Categories

Here Is a quick reference sheet of all the current guided tutorials
available in Adobe Photoshop Elements 2019.

Your Guide _
Easy-to-follow guides

At the time of writing, there are
currently 53 guided edits available in
Adobe Photoshop Elements 2019. Just as the name

They can be accessed from suggests, the Guided

~ the Guided workspace mode is designed to help
page and are you produce a number

: distributed under of creative and artistic
G0 A P six categories. effects by taking you

After (Roll over to see Before.

] F ||E 3 1. Select Number of Pictures

mr (A

4 Pictures

= _ Each one through the process in 8 Pictures 12 Pictures
dE W has a small numbered steps. It is
90 G before and a semi-automatic edit G
o after slider where you click various |
{+38 5 Y that gives you a available options and - - |
- . S  quick overview of Elements does the |
NrdS what each effect is rest for you.

designed to achieve. Small Medium Large

3. Change Background R

Bor File Edit Image Enhance Layer Select Filter View Window Help Fri 8 Mar 07:50:46 Q ¢

Afver (Roll over (o see Before.)
1. Soloct Numbor of Pictures

m | e | oS
P (1N i‘a‘
4 Picbures 8 Pictures 12 PiClures
2. Change Border Width
Small Malium Large

it Bﬂl:hgm

‘ Grodient  Solid Color
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Brightness and Contrast

o This lets you adjust the brightness of your photo and
control how much contrast is present. You can view the
after image only or view both the before and after images either
vertically or horizontally.

Crop Photo

e A crop box will be drawn on your photo so you can resize
that box to whatever size and proportion you like. You can

restrict it to certain proportions and change the overlay to Grid
or Rule of Thirds.

After]
T

1™ 1 l .
| I :'—_ _L.-F' g i el e =

-
=

F

i 2

BT e el e e m g

ey - IR T dal E N
Lighten and Darken

The Lighten and Darken option can be viewed as a more
simplified version of the Levels adjustment option. You
are given three sliders that affect the brightness of Shadows,
Midtones and Highlights.

GUIDED MODE CATEGORIES

Correct Skin Tone

9 Your photos may suffer from a colour cast that can make
your human subject’s skin look a little off in terms of
its colour tone. This guided edit can alter the tan, blush and

lightness of skin.
Wiy

Levels

o This uses a levels adjustment whereby you can alter the
shadows, highlights and middle tones brightness of your
selected image. Any adjustments are made globally across the
entire image.

an E 3
I " ol
B . .,

=1 = 3 ol 2 N —

R TR G T . !

Resize Your Photo

You can output for web and print and will be presented
with a couple of options that control the final size of your
image. You can specify width and height pixel dimensions and
apply the result.
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STARTING WITH PHOTOSHOP ELEMENTS

Rotate and Straighten

o You have the options to rotate your photo clockwise and
anticlockwise and if you have a sloping image, you can use
the Straighten Tool to bring it back to level.

Sharpen Photo

o You can use an Auto Fix sharpening effect or you can use
the supplied slider to manually increase the amount of
sharpening until you have it how you want it.

i

-. J ..“.-. o
L e d ¢l
' i 1B E! 3 4
e | Rt .

Enhance Colours

o This lets you add a soft dark or light border to your image.
You can control its intensity and use sliders to change the
softness of the vignette and its roundness.

Lomo Camera Effect

0 This replicates the effect of the popular and cheap cameras

that create a very specific look due to their low quality
manufacture. You can also add a vignette to the photo.

BDM'’s Independent Manual Series | Volume 19

@ You have an Auto Fix option to make a best-guess at

the correct colour balance and contrast in the photo.
Otherwise, you can use the Hue, Saturation and Lightness sliders
to fine tune it.

Remove a Colour cast

A colour cast is an unwanted bias towards a tone that
spoils the look of your photo. You can use the colour picker
to find an area of pure grey, white or black to remove the cast.




' ——

o

Saturated Film Effect

@ Applying this effect makes your photo look as though

It was shot on old slide film for a much more saturated
look. You can add the effect a number of times to increase the
Intensity of the effect.

— ——
-

“Before .

" gy
=

B&W Colour Pop

@ Select a preset colour or use the colour picker to keep one
colour and turn the rest of the image to black and white.
You can refine the effect and also increase the saturation of the
remaining colour.

F,
e

oo

e

%
%
a

3

¥

1
-.J b
g
+
a
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-

High Key

High key images are characterised by their very bright
appearance with very little shadow detail left in the photo.
You can use a colour or black and white high key effect.

GUIDED MODE CATEGORIES

Black and White

@ This is a guick black and white conversion with four
presets ranging from light to dark. If you want, you can
add a diffuse glow to the image for a dreamy effect or increase
the contrast.

B&W Selection

@ You can use a selection brush to selectively pick out

the areas you want converted to black and white whilst
retaining colour elsewhere. You also have the option to invert the
effect if required.

Line Drawing

This effect mimics the look of a pencil drawing. Click to
convert the photo into a pencil sketch and If you want to,
you can add a small amount of colour back into the image ano
darken the lines.
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Double Exposure

Works in the opposite manner to a high key image. It is You can combine and blend two images together for a
characterised by small amounts of highlight detail and is more creative effect. You can use a preset image or one
dominated by darker tones. You have the colour and black and of your own photos and superimpose it over the subject in your
white options. main compaosition.

DS IN THE AlRAfer

Effects Collage Meme Maker

With this effect, your chosen image is split into a number of @ Great for creating memes for social media. This tool guides
sections chosen by you and then a number of effect styles you by letting you create a meme template, edit your text
are added to each section of the collage. and resize the main subject’'s photo. You can apply new borders
and add effects for a memorable look.

Multi-Photo Text Old Fashioned Photo

You can create visual text using this guide, placing a Converts your photo using one of three black and white
different photo inside each letter. Add your text and then presets; also lets you adjust the tone of the conversion and
one by one, you can place a photo inside each letter. You can the tint colour of the image to create an old fashioned photo.
also add a new background and add effects to the text.
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GUIDED MODE CATEGORIES

Painterly

@ This effect can take your primary subject and make it look @ Turn your photo into a painting with this artistic effect. It
like It Is escaping from the frame of the photo. You can add provides you with a number of preset brushes to paint onto
a frame and then select the area of the shot you want to extend yvour photo. Choose a canvas colour and texture and then add an
outside the frame and add a shadow for more depth. optional effect to enhance the painterly feel.

Partial Sketch Photo Text
@ This gives you a choice of effects that you can apply to @ Use your photo as the basis of creating some creative text
your photo. Then you can simply paint using a brush over effects. Choose your font and how you would like it to
your image where you want the chosen effect to appear. You appear on your photo, then select the background style. You can
can work with more detail if required and change the size and also choose the intensity of bevel drop shadow and outline of
opacity of the brush you use. your text.

Before After

Picture Stack Create Pop Art

Turn your photo into a collage with the Picture Stack Go psychedelic and turn your photo into some fun pop art.
effect. Choose the number of pictures you want your photo Choose from the styles available and then convert it into
divided into and then add a border to each element. Then you a monochrome or posterised version. You can also add a neon
can add a solid or gradient background for the finishing touch. glow if you wish, or tint it a single colour.
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STARTING WITH PHOTOSHOP ELEMENTS

Puzzle Effect Create Reflections

@ Your photo can be turned into a jigsaw puzzle with this @ Add reflections to your photos for eye catching results.
effect. Choose the puzzle piece size you want to use. Simply add the reflection and then use the tools provided
Extract pieces for a more creative effect and arrange them by to colour the reflection, fill the background and then make the
moving them to another part of the design and rotate the pieces reflection look more like glass or water.

If needed.

:

o —
] | i ,
- k| R # e

6%

II.J.I.
Speed Effect

Shape Overlay Effect

@ Choose from a series of different shapes and then position Add some great blurred speed lines for a little more zoom

it over your photo and scale it to the required size. Then IN your photos. Use a selection tool and choose an area of
you can add an effect to both the inside and outside of the your image to apply the effect to. Then you can add the speed
shape's area, before cropping it to your preferred proportions. effect and then precisely refine the look of your finished effect.

After

Speed Pan Zoom Burst Effect

Add motion blur to your backgrounds to give the This mimics the effect of rapidly zooming your camera lens
Impression of fast motion. Select your main subject using while you take the photo. You can crop your photo in order
the selection tools and then add motion blur to the background, to put your primary subject in the centre of the shot and then
keeping your main subject sharp. add the zoom burst effect. Refine the area of focus and add an
optional vignette.
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Depth of Field Frame Creator

@ You can make your subject stand out in the photo by making @ Use your own photos and graphics to create frame designs.
the distracting background blurred as if photographed with Use the tools to select the areas you want to be your frame
very shallow depth of field. You can add simple blur or use more and then save that frame design so you can work on it further in
precise selections for more targeted effects. Expert mode.

Create Orton Effect Perfect Portrait
@ Based on an old slide film technigue pioneered by Michael @ For great looking skin in your portrait photos use these
Orton, you can add a soft and dream-like quality to your tools to heal blemishes in skin, remove red eye and whiten
photos. Apply the Orton effect as many times as you wish and teeth. For a glamorous look to your shots, you can also add a
then use the sliders to enhance the effect even further. glow effect and even slim your subjects down if required.

Recompose Replace Background

This works much in the same way as Photoshop's content- With this set of tools, you can select your primary subject
aware scale tool. This tool lets you scale an image but using one of a number of selection tools and then remove
maintain the important content and detail in the photo. You also their background. Select a new background or texture and
have the option to mask areas for greater control. then place it behind the original to match the colour tones for a
convincing result.
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Restore Old Photo

can improve those old photos with ease.

@ If you have a number of old scanned photos that have many
blemishes on them, then this tool can make them look new

again. Using healing tools, blur tools and clone stamp copies, you

Text and Border Overlay

@ Choose from a selection of border designs to frame your
favourite photos. Choose its size and colour and then add

a text overlay using the type tool. You can then specity the text's
position and edit the text style used.

Watercolour Effect

A simple and effective way to turn your favourite photos
into watercolour paintings. Choose an effect, add a
watercolour paper overlay and a canvas texture. Then you can
refine the effect and add captions in various text styles.

BDM'’s Independent Manual Series | Volume 19

Scratches and Blemishes

@ For any small blemishes and flaws in a photo, use this tool
to quickly fix those troublesome areas with the spot healing

brushes. Larger areas will benefit from the application of the
healing brush.

Tilt-shift

@ Turn your images into miniature effect photos using this
specialised blur tool. It works best on photos taken from
above your subject and from a distance. It mimics the effect of

expensive tilt-shift lenses. Modify the focus area and add blur,
contrast ana saturation.

Photomerge Compose

This allows you to select two photos you wish to work on
and extract from one photo and place it on another to
combine the two. You have selection tools to help you accurately

extract your first subject, then you can place it, move and scale it
on the second photo.




Photomerge Exposure

@ This is a form of high dynamic range photography. This tool
lets you combine two or more different exposures of the
same shot to create a much more exposed version. Use automatic
or manual modes for the final result.

Photomerge Group Shot

@ Use multiple group shot images to make sure everyone has
their eyes open or is looking at the camera. Select two or
similar group shots taken together. Set one as the final Image
and use additional photos to merge preferred elements into the
final photo.

Before ATter

Photomerge Panorama

Great for creating super-wide panoramic shots. Combine
a sequence of several photos that captures a very wide
panoramic scene by merging them. Select your photos, choose
your panorama layout and type of settings and the program
does the rest for you.

GUIDED MODE CATEGORIES

Photomerge Faces

@ Combine facial features from two different portrait photos
for humorous results. Select two faces and open them. You
can then use the alignment tool to pick out three distinct areas
on each face and then blend them together.

Photomerge Scene Cleaner

If you have a series of photos of the same subject but there
are distractions in each, you can combine two or more
ohotos to clean up the scene. Use one base image and blend in
the best parts of additional photos to create a finished result.

=
.

™ i o

il

Don't forget to check out the
inspirational news stories

and guide information
available on the Home
screen. There is plenty
to pique your interest.

What would you like to do today?

e.g. | would like to make a greeting card

| TRY THIS

Create a watercolor effect

Turn any photo into a beautiful, textured
watercolor — and even add text. Try now
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Most modern digital cameras allow you to shoot In a picture
format known as Raw mode. Raw mode is a pure digital readout
of the data captured by the sensor. This offers amazing scope
when it comes to getting the very best out of your photos.

Step Inside your very own digital darkroom and take control of
the final look of your photos. More than that, see how you can
Integrate Adobe Camera Raw (ACR) and Photoshop Elements
for a professional looking workflow solution.
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USING ADOBE CAMERA RAW e

Contents

34 The Camera Raw Interface 37 The Profile Browser
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USING ADOBE CAMERA RAW

The Camera
Raw Interface &

Let's take a look at the ACR interface, see what it has to offer and
also how it can integrate with the Elements Photo Editor.

#® Adobe Photoshop Elements 2019 Editor File Edit Image Layer Type Select Filter View Window Help
@ Camera Raw 11.

In the Raw

Adobe Photoshop Elements 2018
comes with Adobe Camera Raw
supplied. It is more usually referred

to as ACR and lets you process Raw
files from digital cameras as the first
step of your digital photo processing
workflow; but you don’t have to stop
there. You can process your Raw file
and then continue to work with it in
the Photo Editor in either the Quick
or Expert editing modes. It is easy to
get started. Let's take a look at the
ACR interface, see what it has to offer,
and also how it can integrate with the
Elements Photo Editor to help you get
more out of your favourite photos.

o Zoom Tool

A standard zoom in and zoom out

tool that lets you view your image

at Increasing or decreasing levels of
magnification. Each time you click the
zoom tool, the image will be enlargeo
to the next level of magnification.
Wherever you click on your image,

it will magnify and centre it in the
workspace using that clicked point. If
you press Alt on your keyboard, you
can decrease the level of magnification
and zoom out. Right-click the image to
call up the context menu to display all
the preset zoom levels available.

o Hand Tool

The Hand Tool allows you to move your
magnified image around the screen by Help Save Image... Depth: | 8 Bits/Channel
clicking and dragging.

[E 333% ~ _MRK2184.NEF
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e White Balance Tool

To help you remove colour cast from
you photo, you can use the White
Balance Tool to bring the image back
to a more neutral colour cast. Click on
the tool and then place the eyedropper
CUrsor over an area of your picture that
IS elther meant to be white, middle grey
or solid black. It will use that reference
point to neutralise any colour cast.
Right-click the screen to call up the
content menu to display all the white
palance presets available to use.

If you need to crop your image to
different proportions, you can use the

o Crop Tool

Crop Tool to drag a crop box over your
iImage and using the control points on
the box, scale and rotate it to get the
perfect crop for your photo. Right-click
on the cropped image to call up the
context menu to view more proportional
cropping options and to clear the crop If
you need to start again.

6 Straighten Tool

This is particularly useful if you have
strong vertical or horizontal elements In
your photo that need to be levelled so
they are perfectly vertical or horizontal.
Click the Straighten Tool and then click
and draw a line along the part of your
ohoto that needs to be straightened out.
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THE CAMERA RAW INTERFACGE

@ Red Eye Removal Tool

It you happen to have a photo of a
family member or friend whose eyes are
coloured red because a camera flash
IHluminated the blood vessels at the back
of their eyes causing the rea-eye effect,
you can remove the redness using this
tool. Click and drag a marquee selection
over each eye and the program will do
the rest.

o Open Preferences

Opening this dialog box allows you to

set some Camera Raw Preferences such
as where your image settings are saved
and whether you automatically sharpen
all Images. You can also set other auto

functions such as tone adjustments and
also specify how DNG files are handled.

o Rotate Image

Lets you rotate your photo clockwise or
anti-clockwise in 90° increments.

Control Tabs

Continue over the page and we delve into the
control tabs, colour treatment options and profiles
of the Adobe Camera Raw interface.

200 _
71 17200 s
: 213 & /
Basic =
Treatment: D Color Black & White
Profile:  Adobe Standard E g
White Balance: Custom "
Temperature 5200
‘
Tint -1
Auto Default
i +0.80
e
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The Camera
Raw Interface

Our journey around the Adobe Camera Raw interface continues
with more of the tools to bring the most out of your photos.

o FU" Screen MOde @ Adobe Photoshop Elements 2019 Editor File Edit Image Layer Type Select Filter View Window Help

Clicking this button lets you toggle the
full screen mode. When you do, no file
menus will be visible until you toggle
full screen off again.

@ Shadow Clipping

Shadow Clipping is there to warn you if
any of the darkest tones in your photo
become solid black. A blue highlight
will appear to warn you which parts of
the photo are clipped.

0 The Histogram

This Is a graphical representation of the
distribution of colour and tonal values
throughout the image. The amount

of tones in any given part of the tonal
range are shown as peaks along the
length of the histogram.

@ Highlight Clipping

This works in the same way as the
Shadow Clipping warning. If any of

the brightest highlights in the image
are solid white, or get pushed to solid
white as a result of editing, they will be
displayed as red highlights.

@ Information Panel

The left side of the panel shows the
RGB values of the image at the cursor
position. The right side of the panel
displays the exposure information for

the image such as aperture, shutter
speed and |ISO.

Camera Raw 11.

QM 2 e e = OC

200%
300%
400%
800%
1600%

& / B Bits/Channel |
| 16 Bits/Channel ﬂ
R e e 1 Y

8 Bits/Channel

Depth:

‘ _MRK2281.NEF

=

Fit in View

Save Image... Depth: B Bits/Channe!
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@ Control Tabs

The ACR interface breaks down the
workflow process into discreet sections.
First is the Basic panel where the
majority of your processing will be
done. You can control all the basic
exposure and colour adjustments

nere. The Detail tab reveals sliders

for controlling Sharpening and Noise
Reduction. The Camera Calibration tab
ets you specifty the calibration process
yOUu are using.

@ Treatment and Profile

Gives you the choice of processing your

Profile menu allows you to choose from
a number of preset colour profiles and
a series of artistic, modern and vintage
effects too.

@ Zoom Levels

Instead of using the Zoom Tool, you can
use the Zoom Level options.

Q View and Settings

The buttons let you cycle through the
available before and after view options,
swap the before and after settings, copy
the current settings to the before image
and toggle between the current settings

THE CAMERA RAW INTERFACGE

@ Help and Save

Help accesses the Adobe help files for
ACR processing, whilst the Save button
allows you to save your current edits to
DNG file format.

@ Depth

Choose from 8 Bits/Channel and 16 Bits/

Channel colour depth.

@ Done, Cancel, Open Image

Done Commits all edits and exits without

opening the file. Cancel quits without
accepting any changes and Open Image

photos in the main colour workspace or
INn the Black and White workspace. The

and the default settings.

: = Fri8@Mar 08:15:06 Q =

will apply changes and open the image
in the Photo Editor.

The Profile Browser

| |
Click on the Profile Browser button and you can
= view all the standard and artistic colour presets
o MR B0e you can use on your photo to alter its colour. There
are a number of camera matching profiles as well
® E— _ as artistic, modern, black and white and vintage.
Treatment: @ Color Black & White

Profile: @ Adobe Standard

oo
oo

White Balance: Custom
Temperature
Tint
Auto  Default B X ; LN "‘#'T..—-r- .__r;::i. .
Exposure : | S
I:,IrE 30.00 s Adobe Vivid
Contrast
I50 160  15-30@15 mm Highlights -81 p Adobe Haw
| Shadows +73
~ - AT hap ki | 14 @ n‘ — p Camera Matching
‘r_ j' \ g - '." _;:-:;h_ﬁ_____il. Whites -23
it it pai - IR L. ) T
! iy Blacks +15 ¢ Legacy
e Treatment: | Black & White
@ Clarity ¥ Artistic
g 2 . _ - Vibrance
dl% - Profile: | Adobe Standard v | OO
Saturation
ri‘}- I:1 m ".
Artistic 02
i = gl
---.".}'l ; < . ;
T . 1 .
| Artistic §
_“ I-r .
Artistic O Artistic 08
= BEW
B Modern
B Vintage
Done Cancel (Gpen Image)

D
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o USING ADOBE CAMERA RAW

This tutorial
contentis
available for
download

Processing

ACR lets you process Raw files from digital cameras as the first step

of your digital photo processing workflow; but you don't have to stop
there. You can process your Raw file and then continue to work with it In
the Photo Editor, in either the Quick or Expert editing modes.
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Create glass pane effects

Photo
Editor

& |

. Organizer

RECENT FILES

Video
Editor

T _MRK2070.NEF T} hong-kong-1990268....

1 switzerland-862870.jpg ) polynesia-3021072.jpg

1 dog-3277416.jpg 13 monument-valley-53

o To begin, you'll need to open Photoshop Elements 2019
and from the home page click on the Photo Editor icon, this
will activate the Photo Editor program. The default is to open in
Expert mode. You can access Adobe Camera Raw (ACR) from
either the Quick, Guided or Expert mode workspaces.

r || B raw

e

L2
'.'E:_:..

shared Folder

6 The Raw file, in this case a seascape shot in Cornwall, will
open In the ACR workspace, as ACR runs in a separate
window to the Elements Photo Editor. You can use the zoom
tools to fill the active image area of the workspace; you can
clearly see the effect your edits will have on the photo.

CAMERA RAW PROCESSING

ents 2019 Editor File Edit
New b

Open in Camera Raw... ., X 30 |

Open Recently Edited Fit2 3

Image Enhance Layer Select Filter

Process Multiple Files...
Import

Contact Sheet l|...
Picture Package...

9 Go to File > Open in Camera Raw (Alt + Cmd + O) to open
yvour file browser and navigate to the folder that contains
the Raw file you wish to process. Once you have located it,
double-click the file or highlight it and press Open at the bottom
right of the browser window.

Adobe Photoshop Elements 2019 Edito

QM & L. =k te =

straighten Tool [A]

9O C

o A good place to start with a landscape shot like this is

to ensure a nice level horizon. If yours Is sloping, use the
Straighten Tool (A). Click on one side of your horizon line, then
drag across to the other side and release the button to bring it
pack to level.
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R: === |
71 1/
e 7
T IS0 31 15
Basic Razic
Treatment: © Color
“ Temperature 5700
Tint . =1

Exposure +1.00
Contrast 0
_’"m
Highlights 0
e —————

Shadows 0

e Click on the Basic tab to make sure it is the active tab ano
you Will see the range of adjustments available; you can use
these to get the most out of your image. The photo is slightly
underexposed, so a good place to start is to increase the value of
the Exposure by moving the slider to the right.

8 Adobe Photoshop Elements 2008 Editor  File

Highlight clipping warning (O}

71 1,200 =
IS0 31 15-30@15 mm
Basic =
Treatment: © Color [ Black & White
Profile: = Adobe Color =

o If you turn on your Highlight clipping warning (O) and your
Shadow clipping warning (U), you will be shown any areas

of your image that are turning solid black or solid white. These
areas will suffer a loss of detaill so having the warnings turned on
IS useful to avoid degrading the image.

e Camera Raw 0.4 - Miken D0

MRKZOM. HEF

o Now, as you move the slider and Iincrease the exposure,

any areas that are becoming too overexposed will now

be highlighted In red. You can often get away with just a slight
overexposure in your images but beware of pushing it too far and
destroying the image.

BDM'’s Independent Manual Series | Volume 19

Camara Rew 10.4 - Nikon DE1O

Y V2l a
203 15-30815 mm

) (=)

o An alternative to viewing the highlight clipping warning 1s
to press and hold the Alt key while moving the Exposure,
Highlights and Whites sliders to see just the affected highlight

areas without the image itself being seen. It does give you the

chance to fine tune the exposure without taking it too far.



8 Adobe Photoshop Elements 2018 Editor  File EBEdit  Image ayer Type Select Filter View Window

CAMERA RAW PROCESSING

(] Camera Rew 104 - Niken DB

M 2 bowm e = Q0

-

EE 333% MRK2070.HEF

If you are adjusting the Shadows and Blacks sliders, too
much underexposure will be highlighted in blue by the
Shadows clipping warning. Solid plack areas are much like
highlighted areas: you can have a small amount of solid black
areas but beware of heavy underexposure.

Temperature 5700

o I‘l.ar‘.ll
. —e e g
n L]

Tint

Exposure

Contrast 0
Highlights | ,. | 0
shadows - 0 I
————————— e
Whites N 0
Blacks . )

_ﬁ_

0 IT you want ACR to do some of the heavy lifting for you,
there is always the option to click the Auto button. When
you do this, the program will attempt a set of best adjustments
that it thinks will suit the image for optimal exposure. It Is
certainly a good baseline for you to continue editing.

Camera Raw 0.4 - MNiken D10

3 51 WInD 8
b B0 3 15-30815 mm

White Bpfance: | Custom

| & RT3 BN

Tirt &80

%
Dana Reset L Dipan Copy .]

@ Holding down the Alt key while making Shadows and
Blacks adjustments, just the darkest areas turning solid
black will be seen to warn you there is a potential Shadows
clipping problem.

Temperature 5700
Tint -]

uto Default

Exposure +0.7/8
F s
Contrast 0
et
Highlights -75
! 5 ;
Shadows +55
.-p-u ;

Whites =10
Blacks ]

_‘ﬁ_
| -

@ Adjustments are a personal thing of course but we optead

to increase the Exposure, reduce the Highlights to -/5, to
recapture detail in the lightest parts of the image, and pushead
Shadows to +55 to make sure detail was kept In the darkest areas
of the shot. Whites were also reduced slightly to help keep detall
IN the brightest parts of the scene.
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e

Blacks 0

Clarity

Vibrance

Saturation 0

@ Next are the three sliders that affect midtone contrast
and how vivid the colours are. Clarity is a refined version
of global contrast, affecting the middle tones for more detail.
Vibrance affects muted colours first and Saturation is a more
general adjustment for much more vibrant colours.

Detail 25
,-"“M,
R: =-- )
a o fI71 1200s Masking 0
B: -e- ISO 31 15-30@15 mm &'
.__ ‘E Noise Reduction
Detall Detail = Luminance 0
Sharpening . |
Luminance Detail
Amount 40
‘ Luminance Contrast
Radius 1.0
"
—= Color 25
Detail 25
= - Color Detail 50
Masking 0 A\
== Color Smoothness 50
e
Noise Reduction =
Luminance 0

@ The Detail and Masking sliders control artefacts caused
by over-sharpening. The Noise Reduction settings let you
control image noise present in high ISO photos. Beware of very
high noise reduction settings that can make your photo look
muddy and lacking in detail.

Calibration
Image Settings
Camera Raw Defaults
Previous Conversion
v Custom Settings

Clear Imported settings

Save New Camera Raw Defaults
Reset Camera Raw Defaulis

Q To the far right of the adjustment panels, is a small icon
comprised of four lines. When you click on this, you can call
up your image's settings, Save New ACR defaults and reset to
the standard default settings.

BDM'’s Independent Manual Series | Volume 19

E‘ f71 1200 s
iy SO 31 15-30@15 mm
Detail | Datail =
Sharpening
Amount 40
a
Moo ol i 5o o I

@ Click on the Detall tab to control Sharpening and Noise
Reduction in your photo. Sharpening is essentially an
INCrease of contrast between the brightest and darkest edges of
yOour Image.

TEA
IS0 31 15-30@175 mm

TZO00 S

Calibration

s« Version 4 {Current)
Version 3 (2012)
Version 2 (2010)
Version 1 (2003)

@ The Calibration tab is best left at its most current version.
For ACR in this form, Version 4 is the most up to date
Process that offers the most recently improved tools and
functions within ACR. Changing it to older versions will result in
certain improvements not being possible.

v Constrain to Image
v Show Overlay

@ Once you have adjusted the image to your taste, one final
option is to crop your image. Use the Crop Tool (C) to draw
a crop box over your image to remove any unwanted area of the
photo and create a more pleasing composition.



hﬁnppl'yr ﬁﬁénéaé and dismiss dialog without
opening image.

-1-. _-_ ‘--'_. -'T

. Done_ | . Cancel |

G

If you are happy with your photo and the edits you've made

@ you can simply click the Done button and your adjustments
will be saved in what is known as a Sidecar file with an XMP file
extension. This file remembers the edits you've made and applies
them non-destructively to your Raw file when opened.

Eagrm |
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9 The image file will now open in the Elements Photo Editor.
We're going to work on it in Expert mode because we will
need a few extra adjustments and layers to achieve our goal of
making the sky more dramatic.

J U@ O a s

Mormal -

[i
Opacity: IE

8| Layer thumbnai
Backaground

The 'Levels 1 layer will appear above your base image
which will be on a default locked layer called 'Background’.
You will see that it is split into a layer thumbnail and a layer mask
thumbnail. The layer thumbnail controls the levels properties and
the layer mask controls masking properties.

CAMERA RAW PROCESSING

I

Apply changes and open image. Option-click to
lﬂpen image without updating image metadata.

-.—-." “- o
g |

d | -..i’. '."".. F .
. Done | . Cancel | . Open Image |

@ You also have the option to click Open Image and continue
to work on the photo in either of the Quick, Guided or
Expert modes on offer in the Elements Photo Editor. You can
then save the result as a PSD file or jpeg. We've decided the sky
needs to be worked on so we're going to open it.

Create -~
IO & CL
Solid Color...

" Gradient... - Opay

Background Levels

Brightness/ Yon

Hue/Saturation...
Gradient Map...
Photo Filter...

Invert
Throvmby el

@ The first thing you need to do is create a new adjustment
layer. Click on the Create New Fill or Adjustment Layer
icon to expand the dropdown menu and you will see a number
of adjustment layer choices. Click on Levels to add a 'Levels 1’
adjustment layer to the layer stack in the right hand panel.

‘ MNormal

Levels

Channel: | RGB -

&
0 1.00

Output Levels:

When you create an adjustment layer, its properties are
displayed in a panel that will appear when it is added to
the layer stack. In the case of a levels adjustment, there are
three sliders that control brightness of the shadows, middle
tones and highlights.
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@ Move the middle tone slider from the middle to the right:
as you do so, the whole image will get darker. You can also
drag the furthest right highlight slider to the left slightly to make
the clouds a bit whiter. Concentrate on how the sky Is looking
and don't worry about the rest of the image for the moment.

-y
| x o

COLOR

i s

]
s

Switch Fregr{:-und aﬂEaﬂ h:rnund Colors [(X)

@ To do this you must first make sure your Foreground
Colour Is set to Black. You can click the Switch
Foreground icon or press X on your keypboard to swap the
default foreground and background colours around so black is
now the foreground colour.

BDM'’s Independent Manual Series | Volume 19

Quick Guided Expert

Fr—

@ Once you have the sky looking darker and a bit more

dramatic, you will see that the rest of the image is too
dark. What you can do now Is use the layer mask to only let
the levels adjustment affect the sky and level the rest of the
IMmage unchanged.

|

Foreground to Background

—_— i

@ Next you need to click on the Gradient Tool (G). When
you do, the Tool Options Panel will display all Gradient
Tool options. Click on the Edit button and make sure you have
Foreground to Background set as the gradient. Then make sure
the Linear Gradient button is clicked.



Opacity:

Levels 1

Make sure the 'Levels 1" layer mask is clicked to make it

the lighthouse.

@ active and then click and drag a line with your gradient tool
that starts just below the horizon and ends just above the level of

@ If you look at your image now, the sky is darker at the top
and transitions to normal at the horizon and the rest of the
Image Is untouched. The mask you added only lets the
adjustment you made affect the sky at the top and fades to
zero effect where the layer mask is black.

CAMERA RAW PROCESSING

When you let go of the mouse, a gradient will be drawn
on the layer mask that fades from black to white along the
points you clicked with your mouse. Wherever masks are used
remember that black conceals and white reveals.

Levels =

Channel: RGB

v!‘ Auto {

It doesn't have to end there. You can add another Levels

@ Adjustment layer and tweak the overa
iIMmage. You can then go back to the 'Levels

| brightness of the
"adjustment and

Mmake the sky even darker by sliding the mic
further to the right.

dle tone tab even

yments 2019 Editor

File Edit

@ 32% (Levels 1, Layer

-_i

S -y
.
-

Image

New

Open...

Open in Camera Raw...
Open Recently Edited File
Duplicate...

Close

Save
Save As...
Save for Welss..

File Info...

@ If you are happy with the image, you can go to File > Save
As (Shift + Cmd + S) and save your composition as a
Photoshop PSD file with the layers and adjustments intact, which
allows you to return and adjust it still further if you wish.

Enhance

Layer Select Filter

-
at O
\3#0
B

st W

36 S

%

@ Your ACR to Elements workflow example is complete. You
have processed the original Raw file non-destructively,
opened the resulting processed file in the Elements Photo Editor
and made further targeted edits using adjustment layers.
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Saving to

DNG Format

Each digital camera manufacturer has its own custom format for Raw files.
Canon cameras save their Raw files with a .CR2 file extension, whereas Nikon
cameras use their own .NEF files. Not every file format can be read by every
piece of software, hence the creation of the DNG open standard format.

o DNG is a publicly available Raw image format, created by
Adobe as a proprietary image standard. It's able to store

Image data in a more generic format that is widely compatible
with many photo-processing programs. DNG is also known as

Digital Negative.

s B e Oaeess LiwE i, R T e T B

o The Photo Editor will open, but since this is a Raw file,
which cannot be opened directly in the Editor workspace,
Camera Raw will be opened automatically on top of the editor
workspace, with your image ready to be processed and saved In
the alternate DNG format.

BDM'’s Independent Manual Series | Volume 19

o To begin the process, you will need to access the raw

file that needs converting to DNG format. You can open
Elements Organiser and search for the required image. When
you have found it, highlight it, then go down to the taskbar ano
click on the Editor button.

1ts 2019 Editor

File Edit Enhance Layer Sel

N .
Open... %O |
Open in Camera Raw... ;. X0

Open Recently Edited Fl'l[%:f r

Image

o Alternatively, you can bypass Elements Organiser altogether
and just open the Photo Editor directly. At this point, you
can pbe in any of the three modes: Quick, Guided or Expert. You
simply need to be able to click on the Open button and navigate
to your Raw file, or go to File > Open in Camera Raw.




MRK_O022.CR2

KMB

MRK_D016.xmp

.
|
MREK_0405.CR2

Select the file you want to open. In the case of our example,
we have a Raw image shot on a Canon camera with the
CR2 extension. Double-click it to open the file in Camera Raw. At
this point, you can make any adjustments that you require using
your preferred methods.

MRK_0O16.CR2 MR

LA Ly

MREK_D042.xmp

Save Of

Save in Same Location
R ¥ Save in New Location

select Folder... fUsers/markfrost/Public/BDM/The Com...6

File Maming

Example: dng comversion example.dng

dng conversion example v | F

v | #

o The Save Options panel will open, where there is a
comprehensive set of options for your Raw to DNG
conversion. At the top, you have your Destination options. You
can choose Save in Same Location to put it in the same place as
the original Raw file, or Save in New Location.

Format: Digital Negative

Compatibility: Camera Raw /.1 and later w

JPEG Preview: Medium Size wr

| | Embed Fast Load Data

2 - - == ] L . o - 1-* . - - -
Prezerve Pixel Count

| | Use Lossy Compression:

| | Embed Original Raw File

o Below that, you have the Format options panel. This lets
you choose the Compatibility of your file and how readable
it is by older versions of Camera Raw and Lightroom. You can
also select the size of the Jpeg Preview and whether you wish to
Embed Original Raw File in the conversion file.

SAVING TO DNG FORMAT

o A simple number of adjustments have been made including
Exposure, Clarity and Saturation, along with some tweaks
to the Temperature and Tint. When your image looks right, you
can go to the bottom left corner of the Camera Raw screen ana
click on the Save Image button.

Select Folder... MUsers/markfrost/Public/BDM/The Com...9,

File Naming

Example: dng conversion example001.dng

dng conversion example w |

3 Digit Serial Number -

Begin Numbering: 001

File Extension: @ .dng w

o If you choose Save in New Location, you can specify, or
create, a new destination folder for the converted file.
Below that, in the File Naming section, you can choose a
filename for the converted file by typing text and numerals in the
File Naming fields.

E o - g L}
= ot I :

Mew files have been found in your
Watched Folders.

Dropbox

Elements Catalog

When you click Save, the file will be created. If you now
quit and return to Elements Organiser, it will be added to
yvour import list, if it Is within a watched folder. Now you can
activate the DNG file and edit it as you would any other Raw file
IN your catalog.
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GETTING ORGANISED

The Organiser
Workspace

Before you dive in and start using the Organiser and its tools, it's
worth taking a look at the workspace and how its tools are arranged.

@ Elements Organizer File Edit Find View Help

o : - o i :--..- Bl :'Z I. - 5 I

Import | = o | PR people  Plac

Find it

Use Elements Organiser to organise and
share your photos and media files. You
can view thumbnails of all your favourite
Images and media you’ve imported. You My Folders
can view a large thumbnail of a single
media file or smaller thumbnails of

B Albums

2 15 12 04 Beach
s 15 12 04 Custom Name

many media files. You can fix the most W
n n . 19 01 13 River

common problems in the media files by o

using the tools in the Instant Fix tab of animals

dng conversions

the Task panel.
£ 1 The File Menu

The File menu options appear in the

top left of the menu bar. These are the
basic methods for interacting with the
porogram, managing your catalogues and

events
examples
hdr

new images

people

photo book 1
photo book 1
photo book 1.pse
photo book 1.pse

finding, tagging and viewing all of your places
media files. :::n

spread photos

£ The Import Button

tutorials

FEEEEEEEEEEEEE R R

what your photo needs

From the drop-down menu, you can
choose to iImport photos from various
files and folders on your computer, from
yOUr camera and card reader. Another
option lets you search your hard drive.

£ Albums and Folders

Click the Albums button to view any
Photo Albums you may have created.
Click on Folders to display a folder view
of your files.

£7) Folders View

Click a Folder name to display just the
photos within that chosen folder. Click
the All Media button at the top of the
media browser window to display all
images from all folders. ™ ?

5 All Media and Sort By

If you are viewing the content of one
folder, you can click the All Media button

l__

2—3#% ¥

. E—TE . - - S ——
— " Wl

— x - L]
E-:_'n'_'- gl ik o RGP q'—-ﬂ-'}-‘; H‘H

> o o ¥

to leave the selected folder and see all U] 9 - =B g
phOtOS NeXt tO‘ the A” Medla bUttOﬂ |S Hide Panel Undo  Rotate : Add Location Add Event 5 Instant Fix  Editor Slideshow Home Screen

a Sort By drop-down list where you can sl ko bl M
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THE ORGANISER WORKSPACE

sort according to Newest, Oldest, Name browser, the date range of all media anao
and Batches of photos. the View Notifications button.

Click this pbutton to open the Search pane.

6 | Tool Options panel £ Category Tabs You can enter a search parameter or click

v — on any of the search types listed down the

The tools arranged on the left at the At the top of the Organiser window are left hand side of the search panel.

pottom of the screen represent the five clickable tabs. Media displays either

main tools for tagging and organising a folder or the entire catalogue. Click 11 Create and Share

your photos. You can hide the Folders this tab to view photos where you have

panel, Undo steps, Rotate your images, identified faces. Click the Places tab to These two pbuttons reveal drop-down |ists

Add location data, Add an Event, use tag an image with a place on the map. where you can create slide shows, photo

the Instant Fix feature, open the Photo Finally, you can click the Events tab to books, video collages and more. Note

Editor, create a slideshow or return to the display photo tagged as Events. that certain creations require Adobe

Home screen. . . Premiere Elements to be installed for

p— ¢ Media Browser Window video-based tasks. The Share button lets

() Status Bar Y ———————————————————  you email and share your media on social
The contents of your catalogue or a media and image sharing sites.

This small bar displays information such single folder will be displayed in the main o .

as the number of items in the media browser window. 12 Ratlngs and Auto Curate

Ratings lets you filter your search by

any star ratings your images have

been given. Auto Curate automatically

es  Events (0| Create - Share - chooses the best photos for you. You
can specify how many are shortlisted, up

Fri 8 Mar 08:1 3‘1 =

Q Search

All Media 12 Ratings = & # # # & [ |Auto Curate

SO to 500, and the results are displayed in
T SN
£

_ ©® Tags © information the browser window.

i i E -
’ ﬁ. - r T ' 179 ¥ Keywords +
o %Y — = : i 1% . ; [] @ Nature

(] @ Color

D i Photography

(%) Panel Bin

When you click the Keyword/Info
button at the lower right of the
workspace, a panel opens providing
you with a number of different ways
to add keywords and tag photos. An

v Places Tags +~ Information pane is provided where
v Events Tags 4~ INnformation about a selected photo can
be displayed.

You can adjust this slider to see your
iIMmage thumbnails larger or smaller in the
browser window.

(1) Keyword/Info

Click this button to open the Panel Bin
and choose options from the Tags or
Information panel.

Tagging and Keywords

| - /reate
A media organiser is only as |

good as the tagging and -
keywords associated with &' # # +# # 4 | |AULCS,
your images. Spend |

| ometmeusgng  fo @

Add Custom Keywords || Add. | your images to
reap the benefits
when it comes
to searching
and retrieving
them again.

.' | Keywords

ﬁ Mature

ﬁ Color

ﬁ Photography
ﬁ Other

Zoom Keyword /Info . "

Catalog

W leagues
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GETTING ORGANISED

Setting Up

Flements Organiser

Elements Organiser 2019 gives you complete control over how you
Import, search, tag, organise and share your photos and videos.
Organiser scans your files and analyses your photos and can even find

faces ready for you to identify.

~g}

ow Create multi-photo text

WSl T TN I

Vid
Edi

Organizer Photo
Editor

&

s

ite RECENT FILES

1Y reptile-2042906 edit.... & rabbit-1882699.jpg

When you open Elements, you are presented with the
Home Screen. Down In the lower right are the programs
avallable to use or to try a free trial. Click on Organiser to activate
it and follow any on-screen prompts.

lements Organizer keeps track of your media through a i T
“atalog.
Convert...
Nost people keep all their media in one Catalog, which can
lave thousands of photos and videos. You might want a
eparate Catalog for a special purpose, such as business
m‘r’l‘m and| @ O  Enter a name for the new catalog
catalog
My Catalog 1
_atalogs
Import free music into this catalog Rename
) Catalog
Cancel 0K
® Custom g Move
Macintosh HD/U...s/My Catalog ' Remove
Optimize

If you are creating a new folder, you can give it a bespoke
name and then hit the Create button to make the folder
iINnto which your catalogue will be placed. Once you have done
that, you can then give a name to your catalogue. We have called
ours 'My Catalog 1'. Click OK to create It.

BDM'’s Independent Manual Series | Volume 19

Elements Organizer keeps track of your media through a New...
Catalog.
Convert...
Most people keep all their media in one Catalog, which can
have thousands of photos and videos. You might want a
separate Catalog for a special purpose, such as business
photos and videos. Each user of the program can have their
own catalog.
—Catalogs
Rename
(U Catalogs Accessible by the Current User
® Custom Location it
Remove
. Optimize |

9 There |s usually a default catalogue created but you have
the option to use the Catalogue Manager to create a
custom location for your catalogues. Click the Custom Location
and then Browse to the location where you would like to create
your custom catalogue.

videos so you can easily find them later based on
who you were with, where you were and what
you were doing.

Organize your media with the Element

Start Importing

B The Organiser workspace will open and you will see the
mMain Media workspace displayed. If you are using it for the

first time, it will prompt you to start importing images ready to
pe organised.



Finding photos of your
loved ones has never been Lauren(135)
easier L

The Elements Organizer identifies and groups
similar looking faces. Just add a name to easily
access all photos of that person in the People
view.

Scott George (45)

Jenny (25)

Jordan(15)

T
*00

Start Importing Skip

e There are also screens giving you a brief overview of what
each section of the Organiser program can do. The People
section can identify faces for tagging. The Places section can
geotag or let you manually add location data to your images and
Events groups your images by date and time.

Al § €| 2

<>

T = 868 v Wl Public
Favorites shared Folder
E) Recents

++ Dropbox (Personal)
*+ Dropbox (Team BDM)
Q Macintosh HD

Public

2} markfrost

Shared &;
/2 Applications

| Desktop

ﬁ Documents

¢\ iCloud Drive

B domain-AirDrop

Drop Box gopro

Phone Backup

B Oannlnads
J Neu;r-Fn;der
When you click Add Folder, browse to where your folder
of Images are kept and double-click it to add it to the
iImport list. There is a small icon shaped like binoculars that when

highlighted, informs you when new files are added to that folder.
When you are ready, you can hit the Import button.

Screen Shot Screen Shot S

== Add Folder... 2018-0...2 (2).psd  2018-0..2.29.png 8

Click on the People section and it will start the process of
scanning your photos looking for faces so you can organise

9
Images by people. The Places section will display images ready

for you to add location data; unless they already have GPS data
attached, whereby they will be pinned to the map.

SETTING UP ELEMENTS ORGANISER

8.0

Import from following folders 2 subfolders selected from 2 folders
Click on the folder to see its media on right

panel. '

41 P Menmas ° Pictures

v Dropbox (]

k
== Add Folder.. 'ﬁ Remove

o Start the process by clicking the Start Importing button
and Organiser will ask you to add folders from which to
import media and photos from. You can add and subtract as
many folders as you wish. Click Add Folder to choose more, ano
even customise how much content from each is imported.

66 of 170 item(s) imported
fUsers /markfrost/Pu...erial/dawlish 2.jpg

T .

Stop

No media available. Click 'Import’ to add media

8 All the selected media you chose will be imported. It you
W have chosen a lot of Images, you will see a progress bar
listing the items as they are imported. When complete, Organiser
will display a grid view of your images ready for you to start
working on.

o Oct 2018 - Nov 2017 /# Add Event

10 The Events section displays all your photos in chronological
“»" order based on date and time. You can create new events
and stack all images of that event within it. Now that you are
organiseq, let's find a little more about the workspaces on offer.
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Tagging and
Keywords

If your photo library iIs large and scattered across many folders, it

would help if they were tagged and had keywords added to make your
searches more streamlined and efficient. Rather than trawling through
folder after folder, why not tag them with keywords?

! Albums . Folders
7N

My Folders

s aerial

3 ae animals
My Folders v > . £ ' s events
o aerial y 5 . | &y as/ examples
as animals Vst Ao a2 hdr

as events . | - - as people
as examples | ¥ ‘ m_ photos
as hdr '
'« people
M. photos
a2 places

, ) From the Home screen, click on the Elements Organiser » ) We made a folder called 'Places



TAGGING AND KEYWORDS

¥ People Tags =
fm Colleagues
fa Family
fa Friends

¥ Places Tags = -

United Kingdom
~ & ® England
* R @ Newton Abbot

& © B3387

sunrise
Sunrise | | Add

|+ Events Tags -

o Now If you look over at the Places Tags section in the Tags o If you highlight all of the images again, you can add more
panel bin, you will see that location data has been added tags to help you identify the photos at a later date. Under
as a tag, which may consist of several sub categories. If you click the Image Tags panel, you can add custom keywords; in this
the top category, in this case United Kingdom, only the taggeo case, the keyword 'Sunrise’ was used. Click Add to include the
Images will now be seen in the browser window. new keyword.

Options - Clear © Tags o Information
v Keywords + Choose Color...
New Keyword Tag... #EN
" New Sub-Category... Category Name
“ s
| Edit...

CﬂtE‘gﬂl ry [Con

Vafellas @
Cancel OK El

Import Keyword Tags from File...
Save Keyword Tags to File...

Collapse All Keyword Tags
Expand All Keyword Tags

v Show Large Icon

o It is added to the Other category but you can click and 8 INn the New Category window, you can choose a colour
drag to any of the other categories; or click the green plus > for your category icon as well as choosing the name you
symbpbol In the top right corner and click on the New Category want the new category to be called, in this case 'Sunlght’. If you
option in the drop down menu that appears. When you do, the wish, you can even select an icon from the choices listed in the
New Category window opens. category lcon window. Then you can click OK to proceed.

. MNature

™ People Tags

o

E e fim Colleagues
o, g2 Family
m e ( 8] = ﬂ |
- -I: % Friends
* People Tags -
| * Places Tags = -

F& Colleagues

gy ; E United Kingdom
Fm Family
g )y The newly hamed category Is added to the Keywords list. 10 AS you can see, we had tagged the photos with a specific
" You can drag and drop the its Image Tag into this new " Places Tag and also with the new Sunlight category and
folder. If you turn off the Places Tags visibility icon and then click sunrise image tags. These various sets of tags mean that it we
on the new category’s visibility icon, your images will still be ever need to find a sunrise photo taken on Haytor, we can just
displayed in the browser window. search for those particular criteria and they will be displayead.
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 --' Folders

Al FE%F-"E [_| Hide Small Stack

Click on the People tab to open the workspace for

tagging

faces. Just like the main Media view, you can view the

contents of selected folders or click the All People button for a
view of every face that has been found in your entire catalogue

of images; this includes those in the UnNamed category.

Add Name {4}%
[a2| Photos Faces

Add Nam

If you hover your cursor over any given thumbnail, it
displays two options. One shows all the complete photos

of that person and the other just shows a small thumbnail of
their face without any background context to distract from the

orocess of identifying them.

o6

BDM'’s Independent Manual Series | Volume 19

Putting Names
{O Faces

Now that you've tagged a few photos, let's move over to the People
workspace. Your library was scanned for all faces present in the photos
and then displayed here. Now you can tag these people and literally put
names to faces to aid you in your search for friends and family.

Hide Small Stacks

Add Name (5) Add Name (4)

Add Name (2) Add Name (2)

Add Name (4) Add Name (4)

Add Name (2) Add Name (2)

9 The view you are presented with is a thumbnail portrait
of each Iindividual face that has been identified. Below

the thumbnail are the words Add Name followed by a number.
The number represents how many pictures of that person have

been found.

Ursual Romanovich

| This action will move "Ursual Rot

Add Name (3)

To hame a known person, Ursula Romanovich In this case,
you can click on Add Name and type in their name. Next to

the name is a small tick and cross icon. Click the cross to cancel
iInputing the name or click the tick to assign that name to the
person. Doing this will move them to the Named category.



Ursula Romanovich | | X

| I. Ursula Romanovich

If some photos of that person have been missed and are

thumbnails and click Add Name. If the facial match Is close

enough, the name will be displayed and you can simply click it
and click the tick button to add those images to the list.

o still available in the UnNamed category, you can click those

On other occasions, if you name a person and then view
their photos in the Named category, you may be shown
a series of additional pictures and asked If they are also of that
person. You can also multi-select those that are not the person
you want and click the Not This Person in the taskbar.

NS Add Group |

‘Rnch Band ‘

MName:

Croup: | None b

OK g

Cancel

| 9" Under Name, you can type the name of the group; we just
- called it 'Rock band’. The Group It appears in is None since
we want to create this as a brand new Group category to appear

INn the All People panel bin. When you're ready, you can click OK
to create the new group.

PUTTING NAMES TO FACES

Is Ursula Romanovich

Rename E

Don't Show Again
Assign as Profile Picture

o Sometimes a photo of a person that is very similar to
another may be added by mistake. If that is the case, you

can right-click the offending thumbnail and choose 'Not Ursula
Romanovich' to remove them from the list.

< All People

Groups :f:
Colleagques q

Fﬂ v Eename

Fﬁ Family Delete

?ﬁ Friends I

'8 As an example of grouping, here are five members of a rock
" band: it would be handy to group the mempers for easier

searching later on. To do this, go to the small the green plus

symbol in the All People panel to open the Add Group dialog box

for you to create a hew group for the members of the banda.

?ﬁ Family
?ﬁ Friends

l?ﬁ Rock Band

Ungrouped

The new group called 'Rock Band' will appear in the All

People panel bin. Now you can highlight all five members of
the band and drag their thumbnails into the 'Rock Band' group. If

you click on their group folder, only their faces will be displayed
since the tag Is relevant only to them.
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Tagging Photos
with Location Data

Tagging places is similar to the way you worked with People. There will
be Unpinned modes and Pinned modes for those photos that have had
their locations identified. We've already touched on adding Location tags
briefly, but now we can explore the Places workspace in more detail.

¥ Group By Time a

Ents Number of Groups: Min ’—@— Max
- Mar 2018 / Add Loc —

/6 >

Search for a location name. Example New Yo

Streets v

rch for a location name. Example

- ;
m %

1 A Click on the Places tab to view the Places workspace. For 29 If you are using this view, then you can alter the Number Of
WY the moment, you will need to be in the UnPinned category W Groups value displayed in the left hand panel. Moving the
and view all the photos that have yet to have any location data slider left and right, increases the numbers of groups on view for
added to them. If you click Group By Time, then they will be more detalled scrutiny or reduces the numper for a broader view
displayed in chronological oraer. of all the photos you are viewing.
! Albums i FﬂIdEFS E“nts
My Folders =1l (& All Media Group By Time * amRRnad
a2 aerial
as] animals
f o Hound Tor
B — Hound Tor, Dartmoor National Park, Newton Abbot, England, United Kingdom |
;;‘ hdr Hound Tor E’lﬂﬁ'&, Churston railway station, Paignton, TQ4 75), United Kingdom
people Toronto, Ontario, Canada
photos Torreén, Coahuila, Mexico
as| places Torrance, California, United States _
a2 raw
e Buckfast
las Sport

Buckfastleid

Fem

@D On the right of your Places workspace is the map where

We have opted to tag a specific group of shots taken at a A
W@ you can view any pinned photos. If you know where you

location called Hound Tor. These shots are kept in a folder

called 'photos’, so we have used the folder view to find them. are looking on the map, you can zoom directly to that place,
We haven't worried about viewing in chronological order in this otherwise you can search for a location by putting a name in the
iINstance. There are four images to tag. search pane at the top of the map.
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[ Place 4 Media Here? + & 1

multi-select the images for location tagging. Then enter

your search destination in the Search panel above the map. Press

enter and a list of matches will be displayed. Click the correct
one and the selected media will be placed in that location.

Now you can see the land better, you simply drag the pin
the right spot and click the Place 4 Media Here? green
tick to confirm placement. You can double-click the pin to view
the images contained at that location. It will also appear in the
Pinned category view now as well.

In the media view panel on the left, press the Cmd key and

Edit location information for selected media

lihatcher Ro{::k_

0 If you import any pictures that contain GPS data, they

' will be automatically replaced on the map in the Places
workspace when the data they contain is analysed. Our
example of some aerial photos taken on the Devon coast were
accurately placed.

TAGGING PHOTOS WITH LOCATION DATA

Satellite ~ §

6 the map is not that precise but it does give you the option
to drag the pin to the correct place. If you are having trouble
identifying the correct area, you can alter the map from Streets
to Satellite for a better view of the land.

A You can also navigate directly to a place you know on the

7 map and then highlight the pictures you wish to place
there. Once highlighted, the pictures can then be dragged and
dropped directly onto the map at the location you navigated to.
These will also appear in the Pinned category.

Sometimes, you may find that the location of the images on

) If the placement area is too broad, you can edit the location
W Information by clicking on the pinned thumbnail anao
iNnputting more precise location options or dragging the pin to a
new |location.
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GETTING ORGANISED

Adding Events
Tags to Pnotos

Having talked about who was In a photo and where was it taken, it seems
only right to mention how you can search for images when you want to
know when something was taken. Now you can tag and group them by
the type of event it was and when that event happened.

M Albums @l Folders

< All Events

11l

My Folders -

aerial

12

animals
M events

Places

& October 1, 2018 / Add Event

[ad exampie . R

a2 hd ; e e

=2 5v Named 517 Suggested

n.] photos ' A —— i,

a2 places | - —- . y

B3 raw Number of Groups: Min =) Max
ad spor @ May 2017 - Apr 2017 / Add Event

We have an example folder full of various types of events 9 Much like the People and Places workspaces, the Events

such as weddings, parties and sporting events. When workspace has a Suggested category for untagged events
viewed In the Events workspace, they are listed by date order to yvet to be identified and a Named category where any that are
help you find what you are looking for. They are listed with most tagged as an event will finally be displayed.

recent dates and times first.

Calend Cl
il I & May 13, 2017 7/ Add Event
2017 ¥ -
Jan Feb
Apr May

7 B 9 10 11
14 15 16 17 18 19 20 & May 13, 2017 / Add Event

F

4 | 22 23 24 25 26 27
28 29 30 31

Jul Aug Sep
Oct Nov Dec
Click the Number Of Groups slider and push it to the far 4 The event we are looking for happened in April - May 2017/.
right Max setting. The media browser will display more W Now you can use the Calendar panel on the far right to
time and date options for you to focus in on. We are looking for open the 201/ calendar and click on either April or May. Clicking
a particular sporting event, Autocross, which was photographeo on May 201/, reveals the photos from that motorsport event.

back in 2017.
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il & May 13,2017 7/ Add Event

) = ] =
2 . o e
ﬁ ﬂ : :

21 spon @ May 13,2017 / Add Event

& May 13,2017 / Add Event

po
. 4

@ Mav 13 2017 7/ Add Event

o The photos are spread out across the duration of the entire
day but are all there ready to be tagged. You can use the

Number Of Groups slider again to break down the view into

fewer groups or more groups of photos split across that day’'s
worth of shooting.

gs = & & & & & [ ]|Auto Curate

Add New Event

Name:

Start Date: 11/19/2018

End Date: 11/19/2018

Group: | Mone -
1 + Description:

Add Event

o Down in the taskbar in the bottom centre of your screen
IS the Add Event button. If you click this it will call up the
Add Event dialog box where you can begin to add detalls about

the event itself such as Event Name, Start and End Date and a
Description if required.

[/13/2017

Autocross Event

"Description

Motosport eV
photographe|
of the Autocr

You will see that all our photos now have a small calendar
icon in their top right corner to indicate they have an
event tag called 'Autocross Event’ added to them. If you look
INn the Named category now, you will see that event listed. Click
on the small information icon to see the description you typed.

ADDING EVENTS TAGS TO PHOTOS

& May 13,2017 /7 Add Event

o Now that you have all the photos in once place, you can
highlight them by pressing Cmd + A to select all, or by
dragging a section around all the photos with your mouse. They

will be highlighted in blue with a small tick box in their bottom
right corner.

Name: |Autocross Event

Start Date: | 5/13/2017 | End Date: | 5/13/2017

Group: |None

Description:

Motosport event photographed on Behalf of the
Autocross Club.|

| Cancel oK 'EI

o Start by giving it a name. We used 'Autocross Event' and
kept the Start and End dates the same since it all occurred

on May 15th 201/. Since no other Group names have been

created, Group is kept as None. A short description is also added.
Now you can click OK to proceed.

L1 = JEr
< AllMedia  Sort By: [Newest - = Ollie
= Autocross Event ‘ | |=| Phil

¥ Places Tags
v ® United Kingdom
v ® England
» ¢ Newton Abbot

v ® Paignton
@ Eastern Esplanade

- Q Torbay
@ Daddyhole Road

v Events Tags

g8 Autocross Event

It you return to the main Media view, you will see that
the Events Tags panel now contains the Autocross Event
tag. If you are viewing all media and click the Autocross Event

tag to make it visible, only the shots tagged will appear in the
browser window.
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GETTING ORGANISED

Reviewing ano
Comparing Images

Within Photoshop Elements, you are provided with a couple of options
that allow you to quickly and easily review photos in the Organiser. You
have the choice of either the Full Screen, or, Side By Side views and can
examine images at multiple levels of magnification.

@ Elements Organizer File Edit Find View Help

* 89 Refresh

Media Types
Import  ~ Hidden Files

Sort By

M Albums @l Folders Sort By:
| Details

My Folders

v/ People Recognition

aerial

animals

ol Timeline

examples
hdr

people

\! 1 . "'. r':_ .
’h: Fir_i.'.i
 § g
. oo Al
places Set Date Range... "\ 3F - flpeed
1 - j
raw oINS
TR
sport ™~ o s WNNERN

\
spread photos :

DR R R R R R R

e - ol

riatrmriale

INn Full Screen view, you can inspect your images in detall
before making a selection of photos and presenting them

It you move your Mouse cursor over the full screen image,
the Control bar will reappear. If you look to the left of the

as an instant slide show. Click and select a thumbnail image in screen, you will see a couple of grey tabs. If you move your
the Media Browser panel and then choose View > Full Screen. cursor over these tabs, you can open the Quick Edit and Quick
The Media Browser will be replaced by the Full Screen view. Organiser panels, again.

o Cloa £ N

Theme Film Strip View settings Fix

-'f £ [i & 'ﬁ

One thing to bear In mind Is that, If you don't see your Film
Strip, you can press Cmd + F on your keyboard to make it

Now, If you move the cursor back to the centre of the
screen and leave it motionless for a short while, this will be

noticed. After a pbrief spell of inactivity, the Control bar, the Quick visible. Clicking on the Film Strip icon in the Full Screen view's

Edit panel and the Quick Organiser panels will all disappear again Control bar will have the same effect as the keystroke option.
until you move the cursor to activate them.
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Settings Fix

L S I

Theme Film5trip View Organize Info

£ The Film Strip positioned below the main image, is there to
W show you all the photos in your Media Browser. If you select
multiple images and then enter Full Screen view, the Film Strip
will only display the photographs you have selected rather than
all your images.

! &
F Theme Film 5trip  View

£ N If you press the spacebar, you can view your photos in a

@ Full Screen view slide show. You can also access the Control
bar and press the Play button to commence the slide show
presentation. To stop the slide show, you can simply press the
spacepar or click the Pause button on the Control bar.

e O Full Screen View Options l
—Presentation Options
Background Music: :Sunn\r_Al‘ternnoni.mpS ¥ Browse...
¥ Play Audio Captions
Page Duration: 2 sec v :

¥ Include Captions ¥ Show Filmstrip

¥ Allow Photos to Resize Repeat Slide Show

Allow Videos to Resize

Cancel OK

#7290 You can also set Page Duration to control how long an
W image is visible before it transitions to the next, in the
presentation. You can also choose to Allow Photos to Resize anad
Allow Videos to Resize. For continuous playback, you can select
Repeat Slide Show.

REVIEWING AND COMPARING IMAGES @

® O [ L
Theme Film Strip View

[ . - - !

b 4 D >

I.".’l.

On the Control bar, you can use the Previous Media and
W Next Media buttons, either side of the main Play button, to
shuffle backwards and forwards through the images displayed on
yvour filmstrip. Alternatively, you can press the left and right arrow
keys on your keyboard.

® O Select Transition

— Classic Fade In/Out— Pan and Zoom— — 3D Pixelate —
O @,

£79) On the Control bar, you will see the button marked Theme.
W This gives you several Transition Options to determine how
one image fades into another, throughout the slide show. Un<ns1:XMLFault xmlns:ns1="http://cxf.apache.org/bindings/xformat"><ns1:faultstring xmlns:ns1="http://cxf.apache.org/bindings/xformat">java.lang.OutOfMemoryError: Java heap space</ns1:faultstring></ns1:XMLFault>